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BEST PRACTICES COURSE – WEEK 17 – Complex Modeling PART 6- 
TrussMaker 
 

Hello, this is Eric Bobrow.  In this ArchiCAD Best Practices training lesson, we'll take a look at 

TrussMaker, a powerful tool for creating trusses and support structures for your building.  This is been 

around for many years, probably going back to version seven or eight of ArchiCAD, but I don't think it's 

widely used.  It has some great conveniences and can work in a variety of ways, but has significant 

limitations.  Get familiar with it, and then you'll know when it's going to be the best tool for modeling 

certain geometry in your building. [0:00:36] 

Now to start out with, I'm going to draw a building.  It's going to be a little bit of a different structure 

here, because I'm going to immediately put on a roof. Using the tools starting in ArchiCAD 15, I can do a 

multi-plane roof and immediately do a gable roof situation here rather than a hip.  So this is something 

that started in version 15.  If you're in an earlier version, you would do something slightly different.  But 

here I'm going to draw a roof along from one end to the other. It will automatically create a gable, and it 

will have an overhang of whatever the settings were on this roof. [0:01:18] 

In fact, if I go in here, I can adjust the multi-plane geometry and the slope.  This says pitch of 6 inches 

and 12 inches. That would be in U.S. more commonly how you might describe it.  Now it's not letting me 

switch to other measurements here, but 6 and 12 and basically a certain overhang.  So this is not the 

focus here, it's just one thing that has been made different in roofs in ArchiCAD 15 is that you can 

actually change the offset here numerically. You can make it less or more and you can do multi-plane 

roofs.  You can actually add planes after the fact if you wanted to do a church steeple or a mansard type 

roof or something like that.  [0:02:11] 

So I'll just leave this alone here and maybe take it up to the 10 foot level, because I think that the walls 

are set at 10 feet. And we'll take a look in 3D. No big surprise that we've got this here.  Now I'm going to 

leave these walls open so we can see into the building, because we're going to be putting in some 

support structures underneath this roof.  This is a simple example of course.  We are going to be able to 

apply this in more complex situations as well.  Now the first thing I want to say is there are some tools, 

aside from TrussMaker, that you can use to put in supports for a roof.  If I go to the object tool here, 

we'll see in the object library in the U.S. and probably available in the international version as well, I can 

go and search for the word "truss" for example and see quite a few different types of truss structures.  

[0:03:08] 

If you're in ArchiCAD before version 14, this search bar may be a little different. You may have 

something saying 'show me things in a folder', or you might have to navigate to the folder. There would 

be a key word area where you could type in the word "truss" if you want to search by keyword. In recent 

versions of ArchiCAD, it's right up here, very convenient.  So if I take something here like this, which 
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might be suitable for this type of structure, I can select it. And it has different types of options here. 

Here For example, do I want to have steel plates?  If you look closely on here and I turn this off and turn 

it on, you'll see little tiny bits of plate that are in there. So there are some options for the number of 

divisions. So if I take this down to six or something like that, it's going to reconfigure.  [0:04:03] 

And of course we have the overall height of this.  This is a 6 feet on 20, so we can adjust that.  I'm going 

to place one of these into the model and we'll see what that looks like.  Obviously, we have many 

different versions here, and some of them actually are quite elaborate.  They're all being created based 

on some structural settings, in other words, how thick you want things.  So we make the cord radius 1 

inch so it will be smaller. And we'll have thinner pipes here. So it actually is building it up to order. If I 

make this longer, 20 inches, it's going to have more pieces. And if I make it shorter like 4 feet, then we'll 

see a smaller piece. It's not going to get distorted; it will just cut it off. [0:04:54] 

So these are quite sophisticated objects.  I will go back to this one here, and we'll place it on the floor 

plan and just look at it a little bit.  I can't place it in 3D, but I can of course drop it into the model here. 

Let's just drag this into position across here.  And I will take a look in this elevation. And see now that 

element is hidden right now because I placed it at the zero level. Let me just do command A.  I guess we 

can't even see this, so we may need to - let's just select it and put it up at a reasonable height. So this is 

the base.  I will take it up to the 10 foot level and then it should show up in that elevation.  [0:05:42] 

So you can see what it's doing here.  I should be able to select this and use the magenta dot and use the 

pet palette to stretch it to a certain length.  This actually perhaps needs to be dropped down.  So I will 

just drag it down like that and stretch this over to the length.  Actually, it's pretty quickly able to get 

something here.  You might have to calculate, because it's showing the dots on the underside rather 

than the top, which I think is a little odd. In my quick modeling, I'd rather be able to snap to the top.  But 

obviously we could do something with this.  [0:06:29] 

Now I'm going to take off this one wall so we can see it in its entirety. And that way, I can actually get 

this a little closer to the right size here.  That's pretty close to being a good fit for it.  The reason I wanted 

to do that is because I want to use this truss that was done with the object tool as the basis for creating 

another way that we might create something using ArchiCAD. I want to show alternatives and then 

show what the unique strengths of TrussMaker are.  So I'm going to go to the marquee tool and draw a 

marquee.  Not everyone knows that you can draw a marquee in an elevation or section and copy the 

information.  [0:07:15] 

And when you're copying it, you're not copying 3D elements.  What you are doing, if I go back and paste 

here, is copying and pasting line work.  Now I just pasted it, and let me click outside the marquee. And 

what you'll see is when I select it, these are just lines.  So it's just a nice way to be able to see the 

elevation on the floor plan.  It's not strictly necessary, but I want to have this as something that I can 
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trace over.  So I'm just going to go in and select this here and get rid of these as well.  It looks like I might 

have lost a tiny bit, because the line of the truss element didn't actually intersect.  [0:08:06] 

Let me take these two, use the intersect option here, and maybe get rid of this line here and clean this 

up a little bit.  So what am I doing?  I'm going to use this as a quick way to have a tracing of what I'd like. 

And let me intersect these two.  So at this point, I have something that if I wanted to create and have 

some variations for it, what I could do is use the wall tool.  And why would I use the wall tool?  Because 

I'm going to demonstrate right now how you could trace something like this with a very short wall, only 

perhaps a few inches or centimeters thick, and have that be the truss lying down.  [0:08:57] 

That might be the way it's shipped or whatever and then it's raised up into position. So you would turn it 

into an object that would be raised up. So I'm going to show you how that works.  We will go to a simple 

wall here, and I'm going to change it to a simple type.  If you are in ArchiCAD 17, this is the option where 

you change from simple to composite to profile. In earlier versions there are slightly different controls 

here.  I will just take it to some type of wood framing as a material, which then gives it a cut fill and a 

surface appearance.  Let's set this up to say that the top is not going to be linked to the next story 

because I am using it for modeling. So I will change it here. [0:09:49] 

And now the controls are similar to what you had before ArchiCAD 17. And I will make this 4 inches, just 

to make it very simple in terms of thickness.  Let's just leave it the 8 inches here and see what we get.  

So I'm going to draw the wall and flip it over. so this control is a little different in 17 here.  It obviously is 

too thick, at least in terms of matching this.  We'll take this down to 4 inches there.  That's relatively 

close.  Having done that, I will eyedrop it using the Option or Alt key shortcut and create the second one 

and perhaps a third one here. So I've now got that. And let me go and switch the wall creation to center. 

Again, these controls are slightly different in 17. [0:10:41] 

You have had center versus edge control for a long time. I will go and take this down to here and maybe 

just for the heck of it I will do a couple of these here. And right now, I'm going to eyeball them a little bit 

here.  What I want to do is show you the principle of this.  So I if I were to take a look at this in 3D, we 

are going to see that I've just draw a series of walls with minimal height. And these are like a truss, or at 

least part of a truss lying down.  So how would I turn that into something vertical?  I can go and select 

these elements, either on the plan or in 3D, and right click and say only show only what is selected in 3D.  

[0:11:48]  

So that's another way to do it. You can do it directly from the 3D window.  I can then go to the View 

menu, 3D View Options, 3D Projection Settings, which allows me to take a view that is very specific.  For 

example, I want a parallel projection. And instead of isometric, I want to take a side view from the top of 

my screen, 90° azimuth. If I click here, that gives me a view looking down on this.  It's actually looking 

sideways on it, but it will be the top.  So with it selected, I go to the File menu, Libraries and Objects, 

Save Selection as Object.  This will create an object where the current view is the floor plan view, which 
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means it has to flip the elements up so that this would make sense as the floor plan view. They are going 

to be rotated up to stand upright.  [0:12:34] 

So this is something that is very useful.  We no longer need to do it for certain things, but it definitely is 

still good. So I'm going to draw this as "Truss walls 1". And I'm not going to go into explaining all the 

steps here, but after I complete that operation, if I go to the object tool it's loaded in. And I can click and 

you can see this object that I have, when I look at it in 3D, and I'll look at it at the previous angle here, 

let's say show all in 3D.  Now you can see here is the object, whereas these are the individual walls.  So 

that's another way that we could create a truss structure.  It's a very quick way to get things that are 

lined up with each other using the wall tool. [0:13:25]  

Of course I could make some of these members thinner or different dimensions, but that is something 

that you can use and it gives you some flexibility.  You're basically drawing it lying down on the floor 

plan.  Now here is another possibility. I will go and select the line work.  I will go and select the line tool 

and select all the lines.  That's interesting; it says select all lines, but it doesn't have the marquee 

reference.  It should be selecting all of the lines within the marquee area, unless they've changed that.  

I'm going to drag a copy of this over to the side. What I want to be able to do now is show that I can use, 

for example, the slab tool. [0:14:15] 

And the slab tool I can set to be a similar type of slab that is done with the wood framing. And perhaps 

that goes zero to two inches, something like that. Then I will use the magic wand to trace this. I just 

clicked with the magic wand with the slab tool. This created the outline in 3D. Now I'm going to go back 

in here and use the option with the editing palette to cut out holes and magic wand each of these.  So 

I'm actually magic wanding each one of these in turn. Now let's see, sometimes just clicking in the 

middle will find the boundaries.  So I'm holding down the space bar so I have the magic wand effect. 

[0:15:13] 

Now if I go to 3D, we'll see that I have something similar.  I just am going to do something sort of 

arbitrary. I will just curve this at these corners. So now this shape - if I go to 3D - is going to have a more 

elaborated form.  So I'm not going to go on and do a ton of work on it, but because it's the slab tool, I 

have the flexibility to work on it with all the controls that a polygon has.  So having done that, I would 

again, go to View menu, 3D View Options, 3D Projection Settings, go back to this side view from 90° and 

then save this selection as an object.  We'll call it "truss slab 1" and go back to the floor plan, go to the 

object tool, and place it.  [0:16:28] 

And if we go to 3D and say show all in 3D and then take our previous view, we'll see that we have a new 

one. And this is the one with the curved pieces.  So these are a few different ways and we can create the 

truss is with an object like this one here.  We can draw walls and then turn it into an object, or we can 

draw a slab. And of course the slabs or walls can be made of different dimensions.  We could have 



 
 

  Best Practices Course – Week 17 Part 6 – © copyright 2014 by Eric Bobrow 
 
 

different materials in there, etc. And we could even do something similar with custom profiles where we 

have steel shapes rather than just simple rectangular sectional pieces. [0:17:15] 

So with that having been said, let's look at how TrussMaker works and what are the differences and the 

advantages to using this tool.  I'm seeing a question from Tracy D'Alessio: "What view did you copy that 

from again?" Okay, so I'm not quite sure, that was from about 10 minutes ago. So I'll just briefly 

mentioned that I had an elevation. I was in this south elevation here, and I drew a marquee, and I was 

able to copy the line work.  So when I do a copy command in a marquee in an elevation or section, it will 

copy the line work. Not the actual elements, but just the line work. And then I pasted it on the plan. 

Tracy says, "Thanks." Okay.  [0:18:05] 

Alright, so let's go back to TrussMaker. The way TrussMaker works is you draw a series of lines, or we 

can actually copy some of these lines here. Since we have a bunch of lines, I'm going to drag a copy up 

here, and then I'll get rid of the actual slab piece.  So now I just have lines here.  Now when we're 

working with TrussMaker, we actually will not draw the lines with a thickness.  So I'm going to do 

something a little odd, I'm going to get rid of every other line here. And this is not going to give me the 

actual correct representation, but it will be a very quick way to get things started here.  [0:19:03] 

I'm going to delete all of those and delete these ones. I am selecting all of the inside edge ones here. 

And then for some reason, there were duplicates here. So I need to get rid of those. I will select these. 

This is a nice trick that you may want to use sometime is to take a bunch of elements that are all going 

to intersect, for example down below, and use the adjust command here. You can use the button or the 

Command dash or Ctrl dash, click on this edge, and they will all adjust here.  And in this case, I also want 

them to adjust to this edge. And notice that only the ones that were intersected get adjusted. And I can 

adjust them to this edge, and only these ones get adjusted.  [0:20:19] 

So now I can go in here, and maybe I could have actually selected all of them and adjusted them there.  

What if I say adjust it to here?  We have a little problem; we don't really want this overhang. So I'm 

going to clean this up by adjusting the endpoints.  What we want to have is a clean representation 

where these lines meet.  Let me move this off to the side.  We can do something like this.  I will show 

where some meet and some are off to the side, just because we want to see what the effect is.  It would 

not be good to have these two cross each other.  So anyway, I'm just doing some quick cleanup.  

[0:21:21] 

In order to get a good result, you would want to measure this.  You would also at this point here drag it 

over to the center and adjust it back down so now this is centered.  I'm not going to worry about the 

other ones, because the principle will be demonstrated.  So I've now got a set of lines that represent the 

members that I want to turn into a truss.  I will select them here, and I will go to the Design menu, and 

under Design Extras we will find TrussMaker.  TrussMaker is installed automatically in ArchiCAD 17.  It's 
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possible in some earlier versions of ArchiCAD that it may not be there directly and you might have to go 

to the Help menu and go to ArchiCAD Downloads or ArchiCAD Goodies. [0:22:22] 

If you go to that page, either ArchiCAD Downloads or ArchiCAD Goodies, you're going to find a page 

which allows you to download ArchiCAD itself, but then there's a page for add-ons. In previous versions 

that might have gone directly to this page of the add-ons.  The add-ons are goodies.  So here we have to 

go click yet again on goodies. And then in this case I have to select my language and things. So select 

USA, and it changed this a little bit. But now we're getting to a page that we used to go directly to from 

the Help menu. [0:23:00] 

It's basically a bunch of different add-ons to ArchiCAD that are free.  They add specific bits of 

functionality to your environment.  You can read the description for each one of them and download 

either the Windows or Mac version and install it.  Often you have to install it and then restart ArchiCAD 

after doing that to see it.  If you're running ArchiCAD you might not see it immediately.  So TrussMaker 

might have been in there, and certainly these are ones that are not in the menus directly.  So if you need 

them, you would install them.  [0:23:41] 

In this version, TrussMaker is actually installed.  I'm going to take this point and move it a little bit to 

make it a little more symmetrical looking.  Okay, so I have these lines selected. I go to the Design menu, 

Design Extras, TrussMaker.  There's the option to create a truss or edit a truss.  We have not created a 

truss using TrussMaker, so obviously, we will create it.  So to do that, you see we instantly get the line 

work displayed in here.  It says that 'pen 4', which happens to be the pen that I was using for this, is 

going to create a profile of a certain width and height with a certain cross section. [0:24:24] 

Now we can change the width and height. This would obviously be a simple cross section, but we have 

options for making it a hollow one or a rolled steel one. And if we pick a rolled steel one, then we can 

actually choose different shapes.  So let me pick a little bit more elaborate shape.  Here it's going to 

show me this.  If I change the dimensions, let me make this a 1 inch and see if that actually adjusts.  You 

can see that this actually changed a little bit to represent that. And if I made the height of 6 inches it's 

going to be taller than it is.  So now you can see it's more of an L shape.  [0:25:04] 

And then in terms of the position relative to those lines, we can choose some options there.  You can 

see what's going on.  Now there's a little X here indicating where the line is. There's a line in space here 

and this is where that cross section would go.  You would want to, as you're using this, get used to the 

placement and understanding where those lines need to be.  But there are some reasonable controls for 

how this would be placed.  Now let me go ahead and check the attributes. This is how the lines would 

look, what layer this new element would be put, what it would be constructed of, and what the surface 

appearance would be.  [0:26:00] 
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In this case, it's not using the building materials in ArchiCAD 17; it's just using the surface. So it doesn't 

interact with elements in a section, like walls and slabs and roofs will.  These are objects that are 

considered somewhat separate from that building materials system.  If we wanted to, we could add 

some things in terms of the way this is working.  So let's see what happens having just set up a basic 

structure here.  We'll say OK, and then it says we're creating a new truss.  It's going to have a name. And 

this is actually an object that goes into the library.  So we can go and save it.  So the only choice here is 

the embedded library.  We can't actually save it out, but I guess it's using a similar dialog box where 

sometimes you could save something out in a folder.  [0:27:01] 

Maybe we would need to have a loaded linked library.  I'm not quite sure why this is shown gray. Let's 

go here and save this.  You can see as soon as I save it, there's a thing that shows up. What is this thing? 

It's the actual new object placed exactly on top of the baseline here.  If I look in 3D, we're going to see 

there is that new structure. It's a little odd because of the shape that I chose, but you can see how 

elaborate this is.  There is a funny thing that there are a bunch of individual lines.  We normally wouldn't 

have that.  It's because when I created it, remember I had copied the line work. So if we go back to the 

floor plan, let me drag this down here. [0:27:58]  

This line, there must be some individual line segments.  Maybe not. Let me drag this. There's not a line 

there. I thought maybe we had multiple pieces there. So it may be because of the complex shape that 

we had, all of these pieces were being done.  I've seen it with more and more of a uniform look.  What I 

did was I drew it on the floor plan. And we could then take this and put it into position.  Let's take a look 

at how we can create these indirectly in a section or an elevation.  So when I create it, it will create it in 

line with whatever elevation or section I'm looking at.  So let's go ahead and create a section through 

the center of the building. [0:28:54]  

By doing that I'm going to actually have a clear path if I open the section where nothing is in here. And I 

can go and perhaps draw some lines.  So I'm going to draw with the line tool. I'm going to turn on this 

layer here that it has selected.  I'm not going to worry about making something too realistic; I just want 

to teach you the principles.  I've drawn four lines with a certain pen. I'm going to switch pens now to a 

different pen, and you'll see what options this now gives me.  So I will take this and mirror a copy across 

there, and then I'll do one more vertically here.  [0:29:46] 

So obviously I'm not doing something very detailed, but I want to quickly show you the principles.  So I 

am going to the line tool now and selecting all of these lines. I activated the line tool, I hit Ctrl+A or 

Command+A to select all of these lines. And I can go to the Design menu, Design Extras, TrussMaker, 

and create a truss. So right here in this section, I can create a truss. And you'll notice that now it has two 

controls.  The blue and the magenta color here.  That's because I drew it with two different pens. So I 

can actually make them with two different thicknesses, whether I'm doing timber construction or the 

steel.  [0:30:35] 
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So the blue ones are supposed to be smaller because they are in the middle. So I will make them let's 

say 2 inches, 2x4. We'll make this one 6x4, something like that. So I'm creating an arbitrary combination 

here, and we can go into the attributes and see that we have some controls here.  Maybe I'm going to 

make this a dark walnut or something like that. And I will say OK. And now it's creating truss two. And it 

says "A new TrussMaker object has been created on the floor plan."  So even though I did it here in the 

section, it placed it on the floor plan. And if I go to the floor plan, you can see that right in line with that 

section there is this thing here. [0:31:41] 

If I go to 3D and we move around in here, you'll see there is the new element that I just created. And 

you can see that some members are thinner and some members are thicker, because of what I drew.  

This contour pen, that's awful. Let's make it a gray so it doesn't stand out in that way.  So that's much 

better. I can make it any color I want.  So you can see how easy it is to create this, and some of the 

options based on choosing profile of these pieces as well as drawing possibly two or more pen colors to 

indicate that there are stronger or thicker members. And there are intermediate members and possibly 

a third level if you want.  [0:32:37] 

Once you've created it, of course we can select this and I can drag copies.  So I will use the multiply 

command, Command+U or Ctrl+U. I will say three copies and I will take them 6 feet on center, just to be 

arbitrary there. And now if I look in 3D, we'll see there they go.  Now what if we change our mind in 

terms of the design?  These are all potentially links.  The way we can edit this is to go back to the 

section, or any section which would show it, and you can see that we've got - actually, if I select this, this 

is one object.  There are several stacked behind it, but we are selecting one of the objects. Having 

selected that, I can go to the Design menu, Design Extras, TrussMaker, and there's an option to edit the 

truss.  [0:33:34] 

When I do that, look at what it does. It actually creates a copy of the original line work for me to edit.  So 

I will place it back on top. It says, "Selected TrussMaker object is invalid." That's interesting.  Let me see 

if I undo edit truss here.  And maybe because it's right on top. I haven't done this recently.  Let me just 

select all of these lines here and we'll delete them. And now I'm going to go back and select the truss, go 

to the Design menu, Design Extras, TrussMaker, Edit Truss, and let's put this back right on top of where 

it needs to be. "Selected TrussMaker object is invalid." Okay. That's a mystery. But we do have this line 

work.  You can see that there are eight lines here. [0:34:34] 

So I'm not quite sure. We'll do a little test separately. I want to go on to say what if we wanted to create 

a different version of this? So I can go back with those lines there in place, either the original ones or the 

ones that I just did, and say "Create a truss".  It has the same information that I had here. So I could go 

and create a variation of this.  And let's just make these members. I'll make them thinner so we can see 

the difference here, and let's say OK.  Now here's truss 3.  If I said make it truss 2, it says, "This already 

exists, do you want to replace it?" If I say replace, now we look in 3D, we're going to see that these 

elements have changed. This is much thinner than what we were seeing before.  [0:35:33] 
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So we can end up revising that design and having it update everywhere.  So that is a powerful feature.  

Let me see if we have any questions.  I see Carol Wiley says, "Why did it turn out longer?"  A good 

question.  If I undo back, let's go to 3D. These elements are certainly longer, the question is what 

determines that.  Now I think what's happening is, if we look in the section here, here's the TrussMaker 

object.  You can see that it is sticking out there. And if we think about the line work, so if we think about 

selecting all the lines here - in fact, actually I undid that. So here are the lines I drew out to the ends of 

the walls here.  [0:36:55] 

And you can see how the body of the truss structure was extended out.  So basically this is the midpoint, 

the axis line there. So let's start over and see if I can get a better result here.  So I'm going to get rid of 

these trusses.  I'm starting that over.  And let's take these two walls up a little bit.  Let's take it unlinked 

here and take them up and then select the roof and those two walls. Use the right click and say Connect, 

Trim Elements to Roof. So this is actually an example of something that I want to demonstrate, because 

in ArchiCAD 17 what I just did gives a difference result than it would have in version 16 and earlier.  So 

there's a different approach you need to take if you want to get a clean result.  [0:38:14] 

So I'm going to undo this.  These elements are selected as well as the two walls and the multi-plane roof. 

When I say connect, we saw the core of the wall sticking up into here. Why? Because the core of this 

wall is drawn with a generic type fills or material that is a higher priority than the roof elements.  So 

again I'll right click and say Connect, Trim Elements to Roof Shell.  See how this line is coming up.  With it 

selected, if I go to the Options, Element Attributes, Building Materials - this is only true for ArchiCAD 17 

or later - we'll see that we have a bunch of different building materials highlighted.  These are the ones 

that are in use. And generic interior material is what I know this wall was drawn with, just from the 

standard template.  [0:39:18] 

We are seeing this alphabetically.  If I click on priority, it will sort it by priority. And you can see that the 

generic interior material has a higher priority than the wood frame and insulation that is the roof 

framing.  So if I want this to stop below that, to have a lower priority, I can drag this up. And you can see 

how not only does it change its position in the list, but it also changed its priority number. Each one of 

these elements has a priority number. So having adjusted that, I say OK. And now this is trimming off a 

little bit better to that.  So having cleaned that up, let's go to the line tool and I will draw - I wonder if we 

can do it with the poly line tool? I can't remember if it allows that. [0:40:18] 

Poly line would give us some interesting options here.  So I'm going to draw this here. And this is actually 

a single line. And let me try something here.  If I know that this is going to be a certain thickness, like 4 

inches cross sectional, I go to the edge of this line and inset it by a distance of 2 inches, half of that.  So 

you can see now this is creating a shape that is 2 inches inset. And I'll go to the line tool and this one was 

with pen 3. Let's just do this one now with pen 4.  I'll do something there as a perpendicular.  That 

created a shape.  [0:41:23] 
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If I select these lines and this poly line, let's see if we can create a truss from that.  So we go to Design 

Extras, TrussMaker, Create a Truss. And it's picking up the poly line and the individual lines. The blue is 

the outside ones. So that's the depth 4 inches, which is the height. So I think that would actually work. 

And then these brown ones would have to be much thinner. I'll make them 1 inch by 2 inches, and we'll 

have something there.  So I'll say OK. Truss 3. New object has been created here.  Now it actually should 

be visible in this view. I believe if we refresh the view, View menu, Refresh, Rebuild from Model, then it 

shows up.  ArchiCAD created the truss object, but didn't refresh the section.  [0:42:24] 

So now we can see that this is fitting within that frame, and it does have an odd situation here where 

the vertical piece here is causing an issue.  So I'm not quite sure how you would want to redraw this to 

make that work. But let's take a look in 3D and see what we have.  So get underneath this one and zoom 

in, and we can see that this is now fitting neatly within it.  So the trick was I used a poly line to create the 

boundary that I wanted, and then I used the pet palette to offset the poly line shape half the distance 

that I wanted this member to be. And then that line became the center line of the truss.  [0:43:20] 

And again I'm not sure what we would want to do here.  Perhaps there may be some issues in terms of 

the way that's handled, maybe we want to draw this connecting line and instead if I go back to that 

section here, instead of doing this as a poly line, I might want to explode it. So I will go to the Edit menu,  

Reshape, Explode. And now this is a line, and this is another line, so perhaps this line I might want to 

make with a different dimension, a different pen. I could make this a smaller piece so it wouldn't 

overlap. Or I might want to take these two lines and intersect them. "Element type cannot be edited." 

Interesting. [0:44:18] 

So this is a poly line, and these are two poly lines. It doesn't let me intersect them, interesting.  As 

opposed to them being lines. I'll just undo this. And I've just, instead of exploding it, I might want go to 

the line tool and magic wand this. And now go to the poly line tool and select poly line and delete it.  So 

now what I have is a line, rather than a poly line, and another line, which I could intersect.  Then perhaps 

I can get rid of this. Now I'm still not sure what we would want in terms of this offset here. So that is 

something that possibly we would need to do. Or maybe this side piece has to be thicker so that it 

would make a thicker end.  [0:45:17] 

Dave Norman says, "The reference line for the truss is in the middle of the members. Can you set the 

reference line to be the outside of the members so the truss does not extend out past the end of the 

wall?" I think you I've been addressing that whole thing of setting up the reference line inset. But let's 

take a look, because I'm not an expert on this. I'm just familiar with the basics of it. I'm going to see if 

there is an option here. Let me undo back and see. I'll get rid of this object here. Take this polygon and 

expand it again back to where we had it down here. And now it is the boundary. We want to make these 

guys go and extend to this edge, extend to this edge, and we'll take this point here and see if I can adjust 

this down.  [0:46:40] 
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So that was interesting. You may not realize if you have multiple elements selected that are linear, like 

lines for walls, and you go to the common end point, you can reposition all of them at the same time.  

I'm literally dragging down the endpoint here using the stretch option.  So now if I select all of these, can 

I go with the Design Extras, TrussMaker, Create Truss, can I specify where this cross section is? Not if it's 

a truss profile here, it doesn't give me any options. If I take rolled steel and make something here, we 

have some options for the position of it, but it doesn't look like we can say that is going to be one 

corner. Even here, profiles, we can do different types of profiles, but it doesn't seem like we have the 

option to specify that we want the outside to go through there.  So that is a limitation that I don't see a 

way around.  [0:47:53] 

So let's see if there are any other questions. "How about in Edit Truss?"  So let's go and see if I undo 

back and get it to where we had this shape at least inset, and then we'll take these guys and try to 

create that truss again.  So we'll repeat the process: Design Extras, TrussMaker, Create Truss, and say 

OK. Save it here, and then rebuild from model, and we see that truss.  So if I select this truss and go to 

the Design Extras, TrussMaker, Edit Truss, what it does is it doesn't actually bring up an editing area for 

working on it.  Let me move this off to the side.  It says, "The selected TrussMaker object is invalid."  

[0:49:11] 

I'm not quite sure what going on, it's probably because the geometry here of this line work is odd 

because of that funny inset.  So we're going to have to simplify it.  I did want to show that if you do 

select the truss there, instead of going to Edit Truss, this is an object.  We can go in here and in that 

object we can for example change that outline and set it to be not so garish.  There are some options for 

how you show the geometry or structure in floor plan, what material or surface appearance there is. It 

says "Angular offset". Let's try a 45 and see what that does. That tilts it so that it's lying partway. So if I 

say OK, you'll see it's now tilted partway on an angle. And that's an interesting option that is available. 

[0:50:16]  

Obviously that doesn't help any of the controls that you wanted.  I just undid that.  I would say 

TrussMaker has some fascinating powerful options and some very frustrating limitations.  Now what we 

might want to do is convert this object after you've created it. If you think about the line work that's 

going to be maybe quicker to do, but you want more controls, what we might want to do is convert this 

to a morph.  So if you're in ArchiCAD 16 or later, you can cover any solid or 3D element into a morph. 

And when I do that it says it's going to replace them with a morph.  Now it looks quite similar, but this 

morph, if I look in 3D, it has made it into multiple pieces for some reason. [0:15:18] 

So we could actually go in here and look at more of the geometry. And I can go and move points around 

here and potentially get this cleaned up.  I'm editing this in 3D.  You'll notice there are some lines here. 

These points are actually on the other side. So I just edited the one face.  It's possible that you could 

turn it into a morph and then clean it up.  So you might use TrussMaker in some cases to make some 

quick things. Of course you could have some complex steel profiles there. There are quite a variety of 
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them. There are some things from junction plates that you can choose. So you may find a quick way to 

get certain shapes and then maybe go in as a morph element and tweak it.  [0:52:18] 

So let's see if there are any other questions here.  So I think this is about as far as I know how to go with 

the TrussMaker.  I think you'll agree that it has some power, but some serious limitations.  It's possible 

there are some things that I'm not familiar with that would make it more flexible, but certainly there's 

clearly a limitation in terms of the geometry. While you can have multiple types of geometry in terms of 

some members thick and some thinner, you can choose some settings for the gravity and the shape how 

it relates to the axis lines that you draw; still, it doesn't allow you to say, "This is where I want the 

outside to be". It has to be center line. At least I don't see a way to control that in any of the things that 

I've looked at.  [0:53:31] 

It is an example of an interesting element that you can draw in a section or an elevation.  Basically 

ArchiCAD will place the center body of that truss directly on top of the section or elevation line on the 

floor plan.  So that is an example.  We can also drop morphs directly in a section or an elevation.  We 

can draw curtain walls directly there.  I did that in the curtain wall advanced section where I wanted a 

vaulted curtain wall roof and did it directly. It basically extruded it directly away from the section line.  

So there are a number of these things.  In the shell tool you can also create elements directly in a section 

or elevation. And starting in ArchiCAD 17, there is the option of dragging copies of elements.  [0:54:29] 

Let's see if I can do that here just for the heck of it.  This is an object here.  Actually can you do it in a 

section or elevation? Let's see if I go to the south elevation.  Can I Edit, Move, Drag a Copy.  This is 

something that you could not do before ArchiCAD 17.  You could not select the 3D element. I'll just take 

a wall and drag a copy.  You can see I've dragged a copy of that wall.  Of course it has no roof to trim to 

so it became taller.  So this is something that was added into ArchiCAD 17.  A very nice improvement.  

Before that, you could only drag a copy of windows or doors within a wall or 2D elements like lines, fills, 

etc.  So that is a nice improvement.  [0:55:26] 

So over the years Graphisoft has made ArchiCAD more flexible in terms of geometry, and here and there 

extended the ability to create geometry and new 3D forms in sections and elevations.  Let's just see if 

we can do it in the 3D window. I can't remember if they added that or not. I select this and drag it here; 

actually I have two things selected. Let me just drag one of them, select this, drag it. And can I use the 

Option key? Yes there's a +, so I just dragged a copy.  So we can do it in 3D as well.  We never could do 

that.  I don't think we can copy this. Copy you can see it grayed. Drag a copy under Move, Drag a Copy is 

available or drag and then use the Option or CTRL key specify what you want to copy.  [0:56:21] 

Alright, let's see. Rick S. asks, "Are you able to vary the materials per pen set?" Not quite sure what you 

mean by materials per pen set. Let's go back to the elevation here.  And where do I have lines? I don't 

have any lines drawn, so let me draw. If I show the layer then maybe there's going to be - there's still no 

lines. I'm just going to draw, mirror a copy; those are two lines in one pen. And I'll do something very 
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simple here. And then we'll go to a different pen here. And let's see what that does. So if I select these 

elements here, go to TrussMaker, Create Truss.  So here you see the pens, and we can change the cross 

section. [0:57:42] 

The attributes here would be just one single type of material or surface appearance, so you cannot 

directly save it. Things in one pen are one material or one surface or one paint color, and things with 

another pen are different, because it's all linked together here.  If we go to these profiles, again we can 

have different shapes. But the attributes, in terms of what surface appearance, does not change.  So 

again struck out there.  If you did convert it into a morph, potentially you could select parts of it and 

change its material.  [0:58:21] 

Carol W. asks, "Is it appropriate to talk about the e-mail I sent you about the rafter tails made with the 

complex profile tool? And is there a better way to create rafter tails that have ornate shapes?"  Carol 

sent in an e-mail. Let's see if I have my e-mail open so we can see this.  Go to inbox and bring that up. So 

here's an illustration of what you're doing with rafter tails.  You mentioned that it's going to be framed 

with trusses, but then have tacked-on rafter tails because of the fire hazard requirements for the area.  

So these are actually just ornamental out here.  So you're creating them with a complex profile, and that 

is essentially the way you need to do it.  [0:59:28] 

I do have a video tutorial that shows a clever way that you can manipulate these that may give you 

some options that you haven't tried out.  I imagine you're trying to create a single profile for this shape 

and maybe another profile for this gable where you are seeing the full length. And that if you wanted to, 

you could change the profile shape of either one of these manually by changing the complex profile 

definition.  I will just demonstrate briefly what I think Carol is doing.  So let's say we wanted to have a 

complex profile outside in this area.  I'm going to go to the fill tool and draw a rotated rectangle here. 

[1:00:17]  

Let's do this, and I'll then adjust this here and take this and do a fill here.  That is one shape, then if we 

wanted to make it a bit more sculpted or something like that we could do something here.  So I have a 

shape and if I select that and copy it and I can go into the Design menu, Complex Profiles, Profile 

Manager.  I can then go to custom to say edit the profile, paste this in. When I hit paste, it says, "Do you 

want to paste it in the current view or original location?" The original location is not relevant, so I'll just 

paste into the current view. I'll go and snap this into position here.  It's generally a good idea to have 

some useful part of the geometry on the origin point or directly above or below it, because this will 

allow us to place the element using that point.  [1:01:17] 

So this would be a nice one, because it would fit into the roof nicely.  We can also potentially have this 

corner be there, but I think this is a bit more intuitive for what we need.  Now I just created this shape 

here. This is a fill. When it comes in as a fill it will adopt a certain building material.  So this is set to be 

brick, which is crazy. So let's just put it into a wood framing or heavy timber. Let's try that.  That is what 
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it would look like in section that can be adjusted by changing how heavy timber is represented.  Actually 

that's in section, not in a straight on view.  So if you were to cut through it, it would indicate that it is 

wood.  [1:02:02] 

But let's just save this. I can save it for use with walls and possibly beams; it might be an interesting one.  

Store the profile and give it a name. So we'll just call this "rafter tail" here. And then there are some 

other things that we might want to change out, but let's see. If I go to the floor plan here and I go to the 

wall tool and choose that, I'd like to create a profile wall. The controls here are again different in 

ArchiCAD 17. There will be a different place in the info box where you switch to a profile. But ultimately 

once you choose that you want a complex profile you will have a choice of these. And here's the rafter 

tail that I just created.  [1:02:50] 

And given where I just did it, I'm going to draw this along the wall.  Now the length that I'm doing - this is 

how deep it is. And I'm going to show you that it really shouldn't be like this. Right now it's on the inside 

here.  Actually I want to flip this over to be on the outside.  You can see how it has the depth of the roof. 

Actually what I want this to be is a very short piece, just a few inches, whatever that thickness is.  And if I 

go to 3D, we're going to see this lying on the ground here. And I can go and say I want to elevate it. Take 

it, use the elevate option, the Shift key to lock it and snap it. [1:03:37] 

In this case I don't have a snap to this in 3D, but I would in a section or elevation. So in fact, if I go back 

to that last elevation I was looking at, you will see here's the element.  I can drag this directly up so it 

snaps there. And now if we look in 3D, we're going to see something like what you had.  So that is a way 

that you can do it. You can draw it as a complex profile. The length that I had drawn it on the floor plan 

here is essentially the thickness of the profile.  So that's the way we would do it. The other thing that I 

have in the video is that if you want, you can have - this is particularly useful if you have two rafter tails 

where the rafter sticks out from the ridge line.  [1:04:30] 

And in fact it might have different lengths depending on how long, how far it is to the ridge line. And 

therefore instead of creating a single profile, because some might be 10 to 15 feet, what you can do is 

actually create a negative profile.  If you think about this in 3D, if we were to create a profile that was a 

around this area, and then place that and use it to cut. We could use it sort of like a saw that is cutting 

off part of the original shape.  So we put in a basic shape, and then use that to trim it.  This particular 

method that I'm talking about, I describe it in one of my tutorial videos. And you may find it useful.  

[1:05:25] 

If I go in here, I'm not quite sure whether I have it in the Best Practices course.  I know I have it in my 

YouTube videos. If you look up "rafter tails ArchiCAD" you can see there's a video here that I created a 

while back. And this will describe the method not so much that I recommend, it's just one of the 

options. You can see here I'll just stop it. This gray shape is a piece that cut off the longer piece. The 

longer piece could be any length, and this is cutting off the end of it.  And one of the neat things is that 
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you can actually have this extend for an entire end of the roof. Let's see if I can find a place here. This is 

a cutoff element, and it's extending across the whole length. And after it's cut off, this element here - 

[1:06:37] 

By the way you can change the shape and actually resave it with a different shape and it will cut things 

off differently. It demonstrates some steps here. And it can cut off all of the ends at once. I can make a 

long piece that is like a template for cutting off those ends. So check out this video, it should be in the 

Best Practices course, but I'm not sure if I've put a copy of it in there. It's definitely available on the 

YouTube channel.  Carol I hope you'll find that useful. I want to thank you for joining me today in the 

lesson for TrussMaker.  This has been Eric Bobrow. Please add your comments and follow-up questions 

on the page down below the recorded video.  Thanks for watching. 

[END OF AUDIO 1:07:27] 


